R-Delivery

Willkommen!
Vielen Dank, dass sie sich fur unser D1 Mini ESP8266-12F v3 Modul von AZ-

Delivery entschieden haben. In den nachfolgenden Seiten werden wir Ihnen

erklaren wie Sie das Gerat einrichten und nutzen konnen.

Viel SpaR!
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Einfuhrung

Das ESP8266-Modul ist ein "System on a Chip" (SoC). Es besteht aus
einem Tensilica L106 32-Bit-Mikrocontroller und einem Wifi-Transceiver. Es
hat 11 GPIO-Pins (General Purpose Input/Output) und einen analogen
Eingang. Das bedeutet, dass Sie ihn wie jeden Arduino oder anderen
Mikrocontroller programmieren konnen. Das Beste an dem ESP8266 ist,
dass Sie mit ihm Uber Wifi kommunizieren kdnnen, so dass Sie mit ihm eine
Verbindung zu lhrem Wifi-Netzwerk herstellen, sich mit dem Internet
verbinden, einen Webserver mit echten Webseiten hosten und |hr
Smartphone mit ihm verbinden koénnen, wusw. Er unterstitzt
Netzwerkprotokolle, wie Wi-Fi, TCP, UDP, HTTP, DNS, etc.

Das AZ-Delivery D1 Mini-Modul ist ein Entwicklungs-Board, das auf dem
ESP8266-Chip basiert. Es hat 11 digitale Ein-/Ausgangspins und einen
analogen E-Pin. Alle digitalen E/A-Pins sind durch Software Interrupt-,
PWM-, 12C- und 1-Draht-fahig. Die analoge Eingangsspannung liegt
zwischen 0V und 3,3V DC. Das Modul verwendet einen microUSB-Port und
den CH340G-Chip mit einer Programmierschaltung zur Programmierung.

AulBerdem fungiert der microUSB-Port als Stromversorgung fur das Modul.

Es gibt verschiedene Maoglichkeiten, das D1-Mini-Modul zu programmieren.
Neben der Arduino IDE gibt es weitere Moglichkeiten, das D1-Minimodul zu
programmieren (offizielles ESP SDK fur C-Programmierung, Lua-

Interpreter, MicroPython-Firmware, sind nur einige von vielen).
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Technische Daten des ESP8266

802.11 b/g/n

Integrierte stromsparende 32-Bit-MCU

Integrierte 10-bit ADC

Integrierter TCP/IP Protokoll-Stapel

Integrierter TR-Schalter, Balun, LNA, Leistungsverstarker
Anpassungsnetzwerk

Integrierte PLL, Regler und Leistungsverwaltungseinheiten
Unterstutzte Antennendiversitat

Wi-Fi 2.4 GHz, unterstutzt WPA/WPA2

Unterstutzt STA/AP/STA+AP Betriebsmodi

Unterstutzt Smart Link-Funktionen fur Android- und iOS-Gerate
SDIO 2.0, (H) SPI, UART, 12C, 12S, IRDA, PWM, GPIO

STBC, 1x1 MIMO, 2x1 MIMO

A-MPDU & A-MSDU-Aggregation und 0,4s Schutzintervall
Tiefschlafleistung <10uA, Abschaltleckstrom < 5uA

Aufwecken und Ubertragen von Paketen in < 2ms
Standby-Leistungsaufnahme von < 1,0 mW (DTIM3)

+20dBm Ausgangsleistung im 802.11b-Modus
Betriebstemperaturbereich: -40 °C ~ 125 °C

und
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Das D1 Mini Modul

Das D1 Mini Modul wird ungeldtet mit einem Paar achtstiftiger Stiftleisten,

einem Paar achtstiftiger Buchsenleisten und einem Paar achtstiftiger

Buchsenleisten mit extra langen Beinen (s. Titelbild).

Technische Daten
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Betriebsspannung:
Hauptchip:
Taktfrequenz:
Flash-Speicher:
Digitale E/A-Pins:
Analoge Eingangspins:

Analoger

Eingangsspannungsbereich:

USB-Anschluss:
USB-Chip:
On-board LED:
Dimensionen:
Max. Spannung

pro digitalen E/A Pin:

3.3V
ESP8266EX
80MHz/160MHz
4MB

11

1

OV bis 3.3V DC

Micro USB

CH340C

verbunden mit dem GPIO2 Pin

25 x 35 x 6mm [0.98 x 1.4 x 0.24in]

12mA
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Digitale E/A Pins

Genau wie der Arduino verfugt das D1 Mini v3 Uber digitale
Ein-/Ausgangspins oder GPIO - General Purpose Input/Output Pins. Wie
der Name schon sagt, konnen sie als digitale Eingange verwendet werden,
um eine digitale Spannung zu lesen, oder als digitale Ausgange, um

entweder OV (Senkenstrom) oder 3,3V (Quellenstrom) auszugeben.

Das D1 Mini v3 hat einen Mikrocontroller der mit einem Spannungsbereicch
von 0V-3,3V arbeitet.

Die maximale Spannung, die von einem einem GPIO Pin bezogen werden

kann betragt 12mA!

Hinweis: Die Pins sind nicht 5V-tolerant, das Anlegen von mehr als
3,6V PRO PIN fuhrt zur Zerstorung des Chips!

GPIO1 und GPIO3 werden als TX und RX der seriellen Schnittstelle
(UART) verwendet, so dass sie in den meisten Fallen nicht als normale E/A

beim Senden/Empfangen von seriellen Daten verwendet werden kann.

Das D1 Mini v3 Modul hat eine integrierte LED, die mit dem GPIOZ2 Pin

verbunden ist.
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PWM

Im Gegensatz zu den meisten Atmel-Chips (Arduino) unterstutzt das D1
Mini Modul keine Hardware-PWM, jedoch wird Software-PWM auf allen
digitalen Pins unterstutzt. Der Standard-PWM-Bereich betragt 10 Bit bei
1kHz, aber dies kann geandert werden (bis zu >14 Bit bei 1kHz).

Analoger Eingang

Das D1 Mini v3 Modul hat einen analogen Eingang mit einem
eingangsbereich von 0V-3,0V. Sollte mehr zugefuhrt werden, konnte dies
den Chip beschadigen. Der ADC (Analog-Digital-Wandler) hat eine
Auflésung von 10 Bit.

Seriell

Das D1 Mini Modul verfugt Uber zwei Hardware-UARTS (serielle
Schnittstellen):

UARTO an den Pins 1 und 3 (TX0 bzw. RX0) und UART1 an den Pins 2 und
8 (TX1 bzw. RX1), jedoch wird der GPIO8 zum Anschluss des Flash-Chips
verwendet. Das bedeutet, dass UART1 nur Daten ubertragen kann. In den

meisten Fallen ist ein UART-Port mehr als ausreichend.

UARTO hat auch eine Hardware-Flusskontrolle an den Pins 15 und 13
(RTSO bzw. CTSO0). Diese beiden Pins kdnnen auch alternativ als TX0- und

RX0-Pins verwendet werden.
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12C

Das D1 Mini Modul v3 verfugt uber keine Hardware TWI (Two Wire
Interface), sondern ist in Software implementiert. Das bedeutet, dass Sie so
ziemlich jede zwei digitalen Pins verwenden konnen. Standardmallig
verwendet die [?C-Bibliothek Pin 4 als SDA und Pin 5 als SCL. (Das
Datenblatt spezifiziert GPIO2 als SDA und GPIO14 als SCL) Die maximale
Geschwindigkeit betragt etwa 450kHz.

SPI

Das D1 Mini Modul v3 verfugt Uber einen SPI-Anschluss, der dem Benutzer
zur Verfugung steht und als HSPI bezeichnet wird. Es kann sowohl im
Slave- als auch im Master-Modus (in Software!) verwendet werden.

Es verwendet:

- GPIO14 als clock — CLK,

- GPIO12 als MISO,

- GPIO13 als MOS/ und

- GPIO15 als Slave Select - SS.
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Pinbelegung

Das D1 Mini v3 Modul hat zwei Reichen mit jeweils 8 Pins (16 insgesamt).

Die Pinbelegung des Moduls sieht wie folgt aus:

[RST ) EB— Y~/ [ 101 ][TXD0)[CS1)[ 10 | Fl
Max. 3.3V A (0% (ToUT) (ADC) P— J ~/ [ 103 ][RxD0)[ 9 | ENN
I3[ 0 ) WAKE 1016 E3— -~ 20(105)[ 1 )
BN (CLK ][5 HsPrEH [[014) R - NE[104][ 2 ]

PN (MiSO)[ 6 |[HsPr](1012] [/ ~NE][100](CS2][ 3] A HIGH Run; LOW Flash
FEN (MosI][ 7 ][RXD2)[CTS0) [HsP] 101 3] A/ J W[ 102][TxD1[ 4 | N
&l CS ][ 8 ][TXD2)[RTS0) [HsPi<s) [015) ilE/ - —i5 (€]

5V G D4 D3 D2 D1 RX
o

o USBJ 5V ]

B Power @ Physical pin /- PWM/I2C/1-Wire

B Ground [] Port pin [] Serial pin

[ Control [ Pin function [ Analog pin
[ ] NodeMCU B Arduino

Hinweis: Das D1 Mini v3 hat einen 5V-Spannungsausgangspin, um die
angeschlossenen externen elektronischen Gerate zu versorgen, aber er ist
nicht SV-tolerant! Der 5V-Pin ist ein Leistungsausgangs-Pin, der die

Leistung vom Mikro-USB-Port ausgibt.

Hinweis: Das D1 Mini v3 hat auch einen 3,3V-Spannungsausgangspin zur
Versorgung externer elektronischer Gerate. Dieser wird vom 3,3V-

Spannungsregler auf dem Board auf 3,3V begrenzt.
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Das D1 Mini v3 Modul - Software

Der Groliteil der Mikrocontroller-Funktionalitat des ESP verwendet genau
dieselbe Syntax wie ein normaler Arduino, was den Einstieg wirklich einfach

macht.

Digitale E/A Pins

Genau wie bei einem normalen Arduino konnen Sie die Funktion eines Pins
mit folgender Codezeile einstellen:

pinMode(pin, mode)

wobei "pin" die GPIO-Nummer ist und "mode" entweder INPUT (was die
Voreinstellung ist), OUTPUT oder INPUT_PULLUP sein kann, um die
eingebauten Pull-up-Widerstande fur GPIO 0-15 zu aktivieren. Um den
Pulldown-Widerstand fur GPIO16 zu  aktivieren, mussen Sie
INPUT_PULLDOWN_16 verwenden.

Um einen Ausgangspin auf HIGH (3,3V) oder LOW (0V) zu setzen, nutzen
Sie folgende Codezeile:

digitalWrite(pin, value)

wobei "pin" der digitale Pin ist und "value" entweder 1 oder 0 (HIGH und

LOW).
Um einen Eingang zu lesen, nutzen Sie digitalRead(pin)

-10 -



R-Delivery

Um die PWM an einem bestimmten Pin zu aktivieren, verwenden Sie:
analogWrite(pin, value)

wobei "pin" der digitale Pin und "va lue" eine Zahl zwischen 0 und 71023 ist.

Um den Bereich des PWM-Ausgangs zu andern, verwenden Sie:
analogWriteRange(new_range)

Die Frequenz kann durch Verwendung folgender Codezeile verandert
werden:
analogWriteFreq(new_frequency)

Wobei "new_frequency" sollte zwischen 100Hz und 71000Hz liegen.
Analoger Eingangspin

Genau wie bei einem Arduino konnen Sie analogRead(A0) verwenden,

um die analoge Spannung am Analogeingang zu erhalten (0 = 0V, 1023 =
1,0V).

Das D1 Mini Modul v3 kann den ADC auch zur Messung der
Versorgungsspannung (VCC) verwenden. Dazu flgen Sie
ADC_MODE (ADC_VCC) oben in lhre Skizze ein, und verwenden Sie

ESP.getVcc( ), um die Spannung tatsachlich zu erhalten.

NOTE: Wenn ein analoger Pin zum  Auslesen der
Versorgungsspannung verwendet wird, konnen Sie an den analogen

Pin nichts anderes anschlieRen!

-1 -
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Serielle Kommunikation

Um UARTO (TX = GPIO1, RX = GPIO3) zu verwenden, konnen Sie
das Serial-Objekt wie bei einem Arduino verwenden:

Serial.begin(baud_reate).
Um die alternativen Pins (TX = GPIO15, RX = GPIO13) zu verwenden,
verwenden Sie Serial.swap()

nach Serial.begin().

Um UART1 (TX = GPIO2) zu verwenden, verwenden Sie das Serial1-
Objekt.

Hinweis: Alle Arduino Stream-Funktionen, wie read(), write(),

print(), println() , ... werden ebenfalls unterstutzt.

I2C- and SPI-Schnittstellen

Sie konnen einfach die Standardsyntax der Arduino-Bibliothek verwenden.

-12 -
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Gemeinsame Nutzung der CPU-Zeit mit dem RF-Teil

Eine Sache, die Sie beim Schreiben von Programmen fur das D1 Mini
Modul (ESP8266) beachten mussen, ist, dass lhr Sketch Ressourcen
(CPU-Zeit und Speicher) mit dem WLAN- und TCP-Stack (der Software, die
im Hintergrund lauft und alle WLAN- und IP-Verbindungen handhabt) teilen
muss. Wenn die Ausfuhrung lhres Codes zu lange dauert und Sie die TCP-
Stacks nicht machen lassen, kdnnte es zu einem Absturz kommen oder Sie
konnten Daten verlieren. Es ist am besten, die Ausfihrungszeit lhres Codes
unter ein paar hundert Millisekunden zu halten. Jedes Mal, wenn der Haupt-
loop wiederholt wird, gibt Ihr Sketch dem WLAN und TCP zugunsten nach,
um alle WLAN- und TCP-Anfragen zu bearbeiten. Wenn |hr loop langer
dauert, mussen Sie den Wifi/TCP-Stacks explizit CPU-Zeit geben, indem
Sie include delay(0) oder yield() verwenden. Wenn Sie das nicht tun,
funktioniert die Netzwerkkommunikation nicht wie erwartet, und wenn sie
langer als 3 Sekunden dauert, setzt der soft WDT (Watchdog-Timer) das
ESP zurick. Wenn der soft WDT deaktiviert ist, setzt der Hardware-WDT
nach etwas mehr als 8 Sekunden den Chip zurick. Aus der Sicht eines
Mikrocontrollers sind 3 Sekunden jedoch eine sehr lange Zeit (240 Millionen
Taktzyklen), so dass Sie davon nicht betroffen sind, es sei denn, Sie fuhren
ein extremes Zahlencrunching durch oder senden extrem lange Strings
uber die serielle Schnittstelle. Denken Sie einfach daran, dass Sie
yield() innerhalb lhrer for- oder while-loops hinzufigen, die langer als,

sagen wir, 700ms dauern konnten.

- 13-
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Wie man die Arduino-IDE einrichtet

Falls die Arduino-IDE nicht installiert ist, folgen Sie dem /ink und laden Sie

die Installationsdatei fur das Betriebssystem lhrer Wahl herunter.

Download the Arduino IDE

Windows installer, for Windows XP and up
Windows zIP file for non admin install

ARDUINO 1.8.9 Windows app Requires Win 81 0r10

The open-source Arduino Software (IDE) makes it easy to Get E8
write code and upload it to the board. It runs on ' '
Windows, Mac 05 X, and Linux. The environment is
written in Java and based on Processing and other open-
source software.

This software can be used with any Arduino board. Linux 32 bits
Refer to the Getting Started page for Installation Linux s4 bits
instructions

Mac OS X 10.8 Mountain Lion or newer

OO,

Linux ARM 32 bits
Linux ARM 64 bits

Release Notes
Source Code
Checksums (sha512)

FUr Windows Benutzer: Doppelklicken Sie auf die heruntergeladene

. exe l-Datei und folgen Sie den Anweisungen im Installationsfenster.

- 14 -
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FUr Linux Benutzer, laden Sie eine Datei mit der Erweiterung . tar.xz
herunter, die extrahiert werden muss. Wenn sie extrahiert ist, gehen Sie in
das extrahierte Verzeichnis und oOffnen Sie das Terminal in diesem
Verzeichnis. Zwei .sh Skripte mussen ausgefuhrt werden, das erste

namens arduino- linux-setup.sh und das zweite heil3t install. sh.

Um das erste Skript im Terminal auszufuhren, 6ffnen Sie das Terminal im
extrahierten Ordner und fuhren Sie den folgenden Befehl aus:

sh arduino-linux-setup.sh user_name

user_name - ist der Name eines Superusers im Linux-Betriebssystem. Ein
Passwort fur den Superuser muss beim Start des Befehls eingegeben
werden. Warten Sie einige Minuten, bis das Skript vollstandig

abgeschlossen ist.

Das zweite Skript mit der Bezeichnung install. sh-Skript muss nach der
Installation des ersten Skripts verwendet werden. Fuhren Sie den folgenden

Befehl im Terminal (extrahiertes Verzeichnis) aus: sh install.sh

Nach der Installation dieser Skripte gehen Sie zu All Apps, wo die

Arduino-IDE installiert ist.
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Fast alle Betriebssysteme werden mit einem vorinstallierten Texteditor
ausgeliefert (z.B. Windows mit Notepad, Linux Ubuntu mit Gedit,
Linux Raspbian mit Leafpad usw.). Alle diese Texteditoren sind fir den

Zweck des eBooks vollkommen in Ordnung.

Zunachst ist zu priifen, ob Ihr PC ein Arduino-Board erkennen kann. Offnen
Sie die frisch installierte Arduino-IDE, und gehen Sie zu:

Tools > Board > {your board name here}
{your board name here} sollte der Arduino/Genuino Uno sein, wie

es auf dem folgenden Bild zu sehen kann:

@ sketch_novi2a | Arduine 1.8.9 (Windows Store 1.8.21.0) - O X
File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch

Fix Encoding & Reload

slketch_nov1 24

1 void Manage Libraries... Ctrl+Shift+] ~
i Serial Monitor Ctrl+Shift+M
< /7] serisipiotter Ctrl+ShiftsL = 7
3
- WIFi101 / WiFiININA Firmware Updater
4 } Board: "Arduino/Genuine Uno" Eoaihbnag o
G Port J Arduinc AVR Boards
6 void Get Board Info Arduino ¥in
o VO1c ®  Arduine/Genuino Uno

7 / / Programmer: "AVRISP mkll" Arduine Duemilanove or Diecimila

~ Burn Bootloader Arduine Mano

Der Port, an den das Arduino-Board angeschlossen ist, muss ausgewahlt
werden. Gehe zu: Tools > Port > {port name goes here} und
wenn das Arduino-Board an den USB-Port angeschlossen ist, ist der

Porthame im Drop-down Menu auf dem vorherigen Bild zu sehen.

- 16 -



R-Delivery

Wenn die Arduino-IDE unter Windows verwendet wird, lauten die

Porthamen wie folgt:

52 sketch_nowv12a | Arduino 1.8.9 (Windows Store 1.8.21.0) - O *
File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_novl 2z Fix Encoding & Reload

- . — . ~
1 void Manage Libraries... Ctrl+ Shift+|

Senal Monitor Ctrl+Shift+M
2 /7] seriiplotter Ctrl+ShiftsL = 7
3 WiFi101 / WiFiNIMA Firmware Updater
4 } Board: "Arduino/Genuino Uno" »
5 Port: "COM3" Serial ports
o~ . Get Board Info cCom
6 void

.. .. v coms

- /,r }‘( Programmer: "AVRISP mikll = -
! =

Burn Bootloader
i~

FUr Linux Benutzer, ist zum Beispiel der Portname /dev/ttyUSBx, wobei

x fUr eine ganze Zahl zwischen 0 und 9 steht.

-17 -
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D1 Mini v3 mit Arduino IDE

Um die Arduino IDE so einzurichten, dass das D1 Mini daruber
programmiert werden kann, folgen Sie ein paar einfachen Schritten.

Als erstes mussen Sie den ESP8266-Core installieren. Um ihn zu
installieren, 6ffnen Sie die Arduino IDE und gehen Sie zu:

File > Preferences

und finden Sie das Feld Additional URLSs.

Preferences x

Settings  Network

Sketchbook location:

C:\Users\slavo\Documents \Arduino Browse
Editor language: System Default «w | (requires restart of Arduino)

Editor font size: 23

Interface scale: Automatic | 100 3 % (requires restart of Arduino)

Theme: Default theme -+ | (requires restart of Arduino)

Show verbose output during: [ compilation [ upload

Compiler warnings: MNone  w

Display line numbers [ Enable Code Folding

Verify code after upload [ use external editor

Check for updates on startup Save when verifying or uploading

[ Use accessibility features

Additional Boards Manager URLs: |https://dl.espressif. com/dlfpackage_esp32_index.json

More preferences can be edited directly in the file

C:\Users\slavo\appDataiLocal \arduino 15\preferences. tut

(edit only when Arduine is not running)

OK Cancel

Dann kopieren Sie folgende URL.:
https://arduino.esp8266.com/stable/package_esp8266com_index.json

und fligen Sie ihn in das Feld Additional URLS ein.

- 18 -
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Wenn Sie bereits einen oder mehrere Links in diesem Feld haben, fugen
Sie einfach ein Komma nach dem letzten Link ein, fugen Sie den neuen
Link nach dem Komma ein und klicken Sie auf die Schaltflache OK.
Schliel3en Sie dann die Arduino-IDE.

@' Additional Boards Manager URLs X

Enter additional URLs, one for each row

https://dl.espressif.com/dl/package esp32 index.json,
https://arduino.esp8266.com/stable/package_espiZéécom_index. jscml

Click for a list of unofficial boards support URLs

0K Cancel

Offnen Sie die Arduino IDE und gehen Sie zu:
Tools > Board > Boards Manager

Es 6ffnet sich ein neues Fenster, geben Sie "esp8266" in das Suchfeld ein
und installieren Sie das Board mit dem Namen "esp8266" von "ESP8266
Community", wie unten abgebildet:

€9 Boards Manager ¥
Type |Al | |espa266|
esp8266 by ESP8266 Community ~

Boards included in this package:

Generic ESPE266 Module, Generic ESP8285 Module, ESPDuino (ESP-13 Module). Adafruit Feather HUZZAH ESPEZ266, Invent One,
XinaBox CW01, ESPresso Lite 1.0, ESPresso Lite 2.0, Phoenix 1.0, Phoenix 2.0, NodeMCU 0.9 (ESP-12 Moduls), NodeMCU 1.0
{ESP-12E Module), Olimex MOD-WIFI-ESPE266(-DEV), SparkFun ESP8266 Thing, SparkFun ESPE2266 Thing Dev, SweatPea
ESP-210, LOLIN{(WEMOS) D1 R2 & mini, LOLIN{WEMOS) D1 mini Pra, LOLIN(WEMOS) D1 mini Lite, WeMos D1 R1, ESPino (ESP-12
Maodule), ThaiEasyElec's ESPino, Wiflnfo, Arduing, 4D Systems gen4 IoD Range, Digistump Oak, WiFiduing, Amperka WiFi Slot,
Seeed Wio Link, ESPectro Core.

Cnline Help
Mare Info

Jetzt haben Sie den ESP8266-Core installiert.

-19-
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Als Nachstes wahlen Sie das richtige Board in der Arduino IDE aus. Offnen

Sie die Arduino IDE und gehen Sie zu:
Tools > Board > {board name}

und wahlen Sie das erste Generic ESP8266 Module aus, wie unten

abgebildet:

€% 16relays | Arduine 1.8.10

File Edit Sketch Tools Help

1Grelays

1 uint
2 void
fo

mood= )
——

8 void

9 fo
10
11 }
T 2 P
£
|

Auto Format

Archive Sketch

Fiz Encoding & Reload
Manage Libraries...
Senial Monitor

Serial Plotter
WiFi101 / WiFiMINA Firmware Updater

Board: "Generic ESP2266 Module”
Builtin Led: "2"

Upload Speed: "115200"

CPU Frequency: "80 MHz"

Crystal Frequency: "26 MHz"

Flash Size: "IME (F5:64KEB OTA:~470KB)"
Flash Mode: "DOUT (compatible)”
Flash Frequency: "40MHz"

Reset Method: "dtr (aka nodemcu)”
Debug port: "Disabled”

Debug Level: "Mone"

IwlP Variant: "v2 Lower Memory"

VWTahles: "Flash"

- 20 -

Ctrl+T

Ctrl+Shift+1
Ctrl+Shift+ M
Ctrl+Shift+L

Boards Manager...

F Y
VintLabs ESP32 Devkit
ESP8266 Boards (2.6.2)
Generic ESP2266 Module
Generic ESP2285 Module
ESPDuino (ESP-13 Module)
Adafruit Feather HUZZAH ESPE266
Invent One
XinaBox CWD01
E5Pressc Lite 1.0
ESPresso Lite 2.0
Phoenix 1.0
Phoenix 2.0
ModeMCU 0.9 (ESP-12 Module)
ModeMCU 1.0 (ESP-12E Module)
Olimex MOD-WIFI-ESPE266(-DEV)
SparkFun ESP8266 Thing
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Wahlen Sie danach den Port aus, an dem das D1 Mini verbunden ist.
Gehen Sie zu: Tools > Port > {port name goes here}

Wenn das D1 Mini Modul v3 Uber den USB-Port verbunden ist, sollten
mehrere Portnamen verfugbar sein. In diesem eBook wird die Arduino IDE

in Windows verwendet, die Porthamen lauten daher wie folgt:

&8 16relays | Arduino 1.8.10 - O x

File Edit Sketch Tools Help

Auto Format Ctrl+T -
Archive Sketch

Fix Encoding & Reload

Manage Libraries... Ctrl+Shift+] D
Serial Monitor Ctrl+Shift+M

Serial Plotter Ctrl+Shift+L

1O WiFi101 / WiFiNINA Firmware Updater F+

b

L)

Board: "Generic ESP2266 Module”

5 } Builtin Led: "2"

Upload Speed: "115200"

CPU Frequency: "80 MHz"

Crystal Frequency: "26 MHz"

Flash Size: "1MB (F5:64KB OTA:~4T0KE)"
Flash Mode: "DOUT (compatible)”

Flash Frequency: "40MHz" > F+
Reset Method: "dtr (aka nodemcu)” > -]_)
Debug port: "Disabled” >

WW W W W v A

Debug Level: "Mone”
IwlP Variant: "vZ Lower Memory"

VTables: "Flash"

Exceptions: "Legacy (new can return nullptr)”
Erase Flash: "Only Sketch”

Espressif FW: "nonos-sdk 2.2.1+100 (190703)"
S5L Support: "All 551 ciphers (most compatible)”
Port: "COM4" ; Serial ports
Get Board Info COM1
¥ COM4

VW W W W v ae

Pronrammer: "AVRISP mikll"

[Tl

For Linux users, port name is /dev/ttyUSBx for example, where “x

represents specific integer number between 0 and 9.
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Blink + PWM + Serial-Sketch-Beispiele

Mit der ESP8266 Library kommt ein Beispiel eines Blink-Sketches.
Um es zu 6ffnen gehen Sie zu:
Files > Examples > ESP8266 > Blink:

void setup() {
pinMode (LED_BUILTIN, OUTPUT); // Initialize the LED_BUILTIN
¥
void loop() {
digitalWrite(LED_BUILTIN, LOW); // Turn the LED on
// Note that LOW is the voltage level
// but actually the LED is on; this is because
// 1t 1is active LOW on the ESP
delay(1000); // Wait for a second
digitalWrite(LED_BUILTIN, HIGH); // Turn the LED off
// by making the voltage HIGH
delay(2000); // Wait for two seconds

Fur das D1 Mini v3 Modul ist LED BUILTIN gleich "2", was bedeutet, dass
die Onboard-LED mit dem GPIO2-Pin verbunden ist. Um die LED
einzuschalten, mussen wir den GP/O2-Pin auf LOW schalten, und um die

LED auszuschalten, missen wir den GP/O2-Pin auf HIGH schalten.
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Software PWM Sketch-Beispiel:

int brightness = 1; // do not set it to the zero
// zero disables the PWM on a specific pin
uint8_t fadeAmount = 5;
void setup() {
pinMode(LED_BUILTIN, OUTPUT);
¥
void Lloop() {
analogWrite(LED_BUILTIN, 200); // high brightness
delay(1000),
analogWrite(LED_BUILTIN, 500);
delay(1000),
analogWrite(LED_BUILTIN, 800);
delay(1000),
analogWrite(LED_BUILTIN, 1000); // 1low brightness
delay(1000),

// fading led
while (1) {
analogWrite(LED _BUILTIN, brightness);
brightness = brightness + fadeAmount;
if (brightness < 0 || brightness >= 1023) {
fadeAmount = -fadeAmount;

}
delay(10);
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Um PWM auf dem D1 Mini Modul (ESP8266) zu verwenden, verwenden wir
einfach dieselbe Funktion wie auf Arduino-Boards

analogWrite(pin, value)

wobei Pin jeder freie GPIO-Pin von ESP8266 ist und "value" das
Tastverhaltnis ist, ein Wert zwischen 1 und 1023.

Verwenden Sie nicht die Null als Wert, weil dadurch die PWM-Funktion

an diesem Pin ausgeschaltet wird!

Je naher der Wert an Null ist, desto hoher ist die Helligkeit der LED.
Je naher der Wert an 1023 liegt, desto dunkler wird die LED.

Um die LED ausblenden zu lassen, muss die while(1) loop innerhalb

loop () Funktion verwendet werden, sonst wird sie nicht funktionieren.
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Das Serielle-Kommunikations-Sketch-Beispiel

void setup() {
Serial.begin(9600);

void loop() {
Serial.println("Hello from the D1 Mini v3 module!");
delay(1000);

Laden Sie den Sketch auf das D1 Mini v3 Modul und offnen Sie den Serial
Monitor (Tools > Serial Monitor). Die Ausgabe sollte wie folgt

aussehen:

D
|

O
X

€

Send

Hello from the D1 Mini module!
Hello from the D1 Mini module!
Hello from the D1 Mini module!
Hello from the D1 Mini module!
Hello from the D1 Mini module!
Hello from the D1 Mini module!
Hello from the D1 Mini module!

Autoscroll [ ] Show timestamp Mewline w | |9600baud Clear output
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Mit der ESP8266-Library kommen viele weitere Sketch-Beispiele. Der Wifi-
Teil vom D1 Mini v3 Modul konnte dort getestet werden, was in diesem

eBook nicht behandelt wird.

€9 Blink | Arduino 1.8.10
File Edit Sketch Tools Help

Mew Ctrl+M

Open... Ctrl+ O

Open Recent

Sketchbook »

Examples : A

Close Ctrl+ W ArduinoOTA

Save Ctrl+5 Ll

SaveAs..  Ctrl+Shift+S EEPROM
ESP2266

Page Setup  Ctrl+Shift+P ESPEIGEAVRISP

Print Ctri+P ESPB26GHTTP Client

Preferences  Cirl+Comma ESPE26BhttpUpdate

. ESP226EHTTPUpdateServer

.0 S ESP266LLMNR
ESP2266mDNS
ESP2266MNetBIOS
ESP82665dFat
ESP826655DP
ESPA266Web5Server
ESPB266WiFi
ESP8266WiFiMesh
EspSoftwareSerial
Ethernet{espl266)
Hash
I HleFSlrenf 3 RAT
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Jetzt sind Sie dran! Entwickeln Sie |Ihre eigenen Projekte und Smart-Home
Installationen. Wie Sie das bewerkstelligen konnen, zeigen wir lhnen
unkompliziert und verstandlich auf unserem Blog. Dort bieten wir Ihnen
Beispielskripte und Tutorials mit interessanten kleinen Projekten an, um
schnell in die Welt der Mikroelektronik einzusteigen. Zusatzlich bietet lhnen
auch das Internet unzahlige Madglichkeiten, um sich in Sachen

Mikroelektronik weiterzubilden.

Falls Sie nach weiteren hochwertigen Produkten fur Arduino und
Raspberry Pi suchen, sind Sie bei AZ-Delivery Vertriebs GmbH
goldrichtig. Wir bieten lhnen zahlreiche Anwendungsbeispiele,
ausfiuhrliche Installationsanleitungen, E-Books, Bibliotheken und

naturlich die Unterstlitzung unserer technischen Experten.

https://az-delivery.de
Viel Spal!

Impressum

https://az-delivery.de/pages/about-us
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